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Introduction  
 

The AxION 2 TOF MS combined with Chromera provides fast and reliable analysis of chemical samples 
by liquid chromatography mass spectrometry. A system consists of an AxION 2 TOF MS, HPLC Pump and 
Autosampler and allows the option of adding a column oven and UV/VIS or Fluorescence detector, if 
desired. These components are connected to a computer using the Windows 7 SP1, 32 bit operating 
system and running the TOF Driver V6.2 and Chromera 3.4.1 software that controls the data acquisition 
procedures and evaluation of results.  

This guide is intended to provide an overview of the workflow to run an AxION 2 TOF MS analysis using 
Chromera. Before beginning, the AxION 2 TOF MS should be installed and connected to the LC instruments. 

Chromera is a powerfully-easy data system for liquid chromatography.  Any laboratory instrumentation is 
only as good as the software behind it. For maximum productivity and long-term return on investment 
(ROI), a Chromatography Data System (CDS) needs to be intuitive, application-focused and scalable. And 
when chromatography is being used in combination with mass spectrometry, the software also needs to 
provide complete control of both techniques and to allow the smooth integration of data from the two 
systems.  

PerkinElmer’s Chromera®
 CDS was specifically developed for chromatographers, but built to provide full 

mass spectrometer control and spectral data handling. This unparalleled integration enables the software to 
smoothly transition from one analytical technique to the other and to seamlessly merge data from the two 
instrument types. Chromera allows users to build and continually adapt a LC/MS system to suit their 
specific needs. By using unique, patented Instrument Device Descriptors, users can quickly and easily 
create custom configurations on the fly.  It provides highly configurable and responsive LC instrument 
control for multi-detector systems, combined with an elegantly simple user interface for interactive 
processing, and flexible, multi-channel quantitation and reporting. Chromera is designed to display all of the 
necessary information on the screen to give you complete control of your system. 
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Overview  

This document provides basic operating instructions for the AxION 2 TOF MS instrument including start-up, 
introduction of samples, data acquisition, data analysis, and shutdown.   

The start-up instructions provided in this chapter assume that Chromera, the TOF MS Driver software, 
and the AxION 2 TOF MS instrument have been correctly installed by a representative of PerkinElmer. 

NOTE: When planning analyses, bear in mind that the instrument needs a minimum of 12 hours from initial 
installation power-on to establish the required vacuum. However, after venting for routine maintenance, 
allow 2 hours after pump down and HV activation to allow equilibration of all electronics prior to 
performing analyses.  

Capillary tubing delivers sample to the ESI, DSA, or APCI probe.  Sample can be delivered from an LC 
system or from the syringe pump.   

  
 

Calibrant Sample 
Inlet: Capillary 
Tubing Connected 
to the ESI Probe 

Nebulizer Gas 
Connections to Dual 
ESI Sprayer 
Note: (Left one is 
referred to as “Cal 
Gas” in software) 
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Starting the AxION 2 TOF MS Detector 
 

 

WARNING!  High voltage is present within the source during 
an experiment.  

 CAUTION!  Do not move the instrument with the power on as 
this may damage the vacuum pumps.   

To start the AxION 2 TOF MS system: 

1. Switch the Power ON/OFF switch to position On (located on the right-side panel). Make sure the 
power switch on the roughing pump is on so that the Vacuum System will start when Pumpdown is 
selected in the AxION 2 TOF MS driver.   

NOTE:  Do not switch the electronics on at this stage. 

2. Check that the fans are operating.  A cooling air flow should exit at the bottom of the instrument. 

3. Double-click on the TOF MS driver icon on the desktop. 

4. Select Pumpdown from the TOF Status menu. 

 

5. Open the Status screen by selecting Status from the Instrument menu to display vacuum status 
during pumpdown. 
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6. Check the vacuum status displayed in the Status screen.  

 
When ready, the Lamps (Power, Vacuum, and Ready) should all be green. 
The Vacuum lamp changes from flashing to steady light at this stage. 

NOTE: The vacuum state light will take several hours to become ready and the system will not be able to load a 
Tune file. 
 

Checking the Position of the ESI Probe 

1. Observe the ESI probe through the inspection window. 

2. Align it to the center of the Capillary by loosening the lock ring and moving the manifold by turning 
the position adjustment screw.  Tighten the lock ring.   

3. The marks on the probe assembly can be used for quick positioning. Observe the needle through the 
inspection window and adjust the tip if necessary. 

4. Loosen the lock ring.   

5. Turn the needle assembly adjustment screw until the needle tip protrudes about 0.5 mm from the 
nozzle. 

 

6. Tighten the lock ring. 
 



 

Starting Chromera 
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Configuring Chromera 
The LC/MS system is configured in Chromera through the Chromera Manager; this acts as a control 
panel for the system. Closing Chromera Manager will not affect data acquisition or processing on a 
running instance of the Chromera. 

 

Creating a System Database 

The first time you install Chromera you must create a System Database. 

To create a System Database: 

1. Create a Chromera Manager shortcut on your desktop.   
Click the Windows Start button, then click All Programs, locate then right-click on Chromera 
Manager, then select Send To > Desktop (create shortcut). 

 

2. Start Chromera Manager by double-clicking on it. 

3. Click the System Database Management button. 
 The system database functions display in the Create tab. 

 

4. Click the Create Database button and observe the progress bar as the system database is created. 

If Chromera Manager has already been configured, you can skip this section. 
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5. Upon successful completion, the next step is to configure “an instrument” for the system. 
In Chromera, an instrument is defined as a collection of devices. For example, individual Devices 
such as Flexar or Series 200 autosamplers, pumps and detectors are combined to create an 
instrument. In addition, a Port Name (for communication to each device) must also be defined in 
the Instrument configuration. Next create an LCMS instrument to use with the AxION 2 TOF MS in a 
system. 

Creating an LCMS Instrument 

NOTE: Prior to creating an Instrument Configuration, make sure all cables are connected between all devices 
and the Edgeport box except for the AxION 2 TOF MS Detector since this device requires an Ethernet 
cable connection). 

To create an LC instrument: 

1. To create a new Instrument Configuration click on the Configuration button  to 
display the initial Configuration screen.  
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2. Under the Instrument Configuration row, click in the box under Configuration Name and type 
an instrument name (this example shows that LC TOF MS was typed), then press the Enter key. 

A    next to the row with the name displays. 

 

3. Click on the  and the Device row displays. 

 

4. Click on the drop-down button in Device Name box, and device choices appear. Select the 
appropriate devices (modules) for the Instrument you are creating. 
In this example, select AxION 2 from the drop-down list of devices. 

 

The AxION 2 detector automatically fills in the Port Name field with COM DLL. 
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5. Select your LC Pump from the Device Name drop-down list. 
In this example, the Flexar FX-10 UHPLC Pump. 

 

6. To determine a correct Port Name for the pump, open the Edgeport Configuration Utility from 
the Start button > All Programs > Digi USB > Edgeport Configuration Utility. 

 

7. The Edgeport Properties dialog displays.  Click the plus sign  to display a list of the physical 
Ports (1 – 8) on the Edgeport with the corresponding COM port numbers. 
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8. In the Device Name pump row (in this example, Series 275 HRes Binary Micro Pump), click on the 
drop-down button in the Port Name field. 

9. Select COM4 from the Port Name drop-down list. 
If your LC Pump is plugged into Port 1 on the Edgeport the corresponding COM port is COM4 as 
shown in the Edgeport Properties dialog above. 

 

10. Select your LC Autosampler from the Device Name drop-down list. 

11. Select the Port Name for the autosampler. 
If your autosampler is plugged into Port 2 on the Edgeport the corresponding COM port is COM5. 

12. Observe the Database Name fields.  This is where you define the database names.   

 

The field Database Name is the name of the active database.  The default database is Chromera. 
The field Archive Database Name is the name of the archived database when an archive is created.  
The default archive database is Chromera Archive.  You can change the default names by typing new 
names into these fields.  If the names are changed, the you must click the Save button. 

13. When all instrument components have been defined, click the Save button 
 located at the top of the screen.  

 
Once you save, the Configuration Name (in this example LC TOF MS) displays in the 
Configuration pane. 
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14. Click Launch to launch Chromera. 

 

Chromera starts and displays Device Connections as it connects to the devices. 

 
 
 Upon successful connection, the Run Time screen displays. 

Setting the Operate Method 

At this time you must assign an Operate method.  The Standby method not selectable; all you have to 
do is apply it when necessary. 

NOTE: When you close Chromera you lose the Operate method settings.  You must reassign it every time you 
Launch Chromera. 

1. In the Operate row, click Browse for method. 
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The Select Operate Method dialog displays. 

  

2. Select the method you created in the TOF MS driver, then click Open. 
This example shows Caffeine Analysis.tofmethod2 

3. Look at the Manual Control section of the Run Time screen. 

 

4. To verify the methods work with Chromera, in the Standby row click Apply. 
Observe that in the Status Panel, the MS Detector State displays Standby. 
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NOTE:     The default “Method” folder displayed in the Select Operate Method dialog is the ONLY location from 
where TOF MS Driver method can be selected.  The Full path is 
C:\ProgramData\PerkinElmer\AxION\Method 

 If a method is saved elsewhere, it must be moved to this folder to be applied properly.  If a method is 
applied outside of the designated folder, Chromera will need to be restarted to proceed. 

5. Next, in the Operate row click Apply. 

 
Observe that in the Status Panel, the MS Detector State displays Operate. 

6. Leave the AxION 2 TOF MS Detector in the Operate mode. 

Setting the TOF Data Path 

When you are in Chromera, follow this procedure to set the appropriate folder to deposit the TOF data 
files.  Failure to do so may fill the local C:\ drive. 

1. In Chromera, select Preferences from the Tools menu. 

 

2. When the Preferences window opens look for Location of MS Data Files under Device 
Preferences as shown below. 
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3. Click the Browse button. 
The Browse For Folder dialog displays. 

    

4. Expand My Computer and select System (C:) 
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5. Click the Make New Folder button. The New Folder displays. 

6. Right-click on New Folder and rename it MSData. 

7. Click OK.  
The location of MS data files are now set to C:\MSData. 

 

8. The Save button in Preferences should be highlighted; click it to save changes. 

 
The TOF data will now be written to C:\MSData as defined in the preferences. 
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AutoTune the AxION 2 TOF MS Detector 

Tuning the AxION 2 TOF sets ion source and ion lenses parameters to obtain optimal resolution and 
sensitivity, and involves adjusting the probes. Even though the instrument is tuned at the factory, it may 
be necessary to re-tune during installation.  Tunings are recommended after running many applications, 
or when performance is not fulfilled. 

Overview  of the Tuning Procedure 

The AxION 2 AutoTune is a script base program that tunes the time of fight mass spectrometer to 
optimize for signal intensity, resolution and peak symmetry. AutoTune works by ramping essential 
parameters in the ion optics and the flight tube optics The important tuning parameters are the hexapole 
DC offset, which controls signal intensity and to some degree resolution, the reflectron and PL1 Bias in 
the flight tube optics controls peak intensity, peak shape and resolution, lens1 (L1) and lens 3 (L3) and 
Lens 2 and Lens 4 (L4) are ramped in pairs these parameters control peak intensity and resolution and to 
a lesser degree peak symmetry.  The schematic below shows an illustration of the tuning optics.  Ions 
travel from the ion optics region where they pass through the hexapole and then into the lens stack 
where they then enter the pusher puller or pulser stack. From the pulser stack ions are ejected into the 
flight tube where they are accelerated up the tube to the reflectron and are then accelerated again down 
the flight tube until they finally reach the detector. 

 

AutoTune also normalizes the Data Acquisition Unit (DAU) which provides a proper baseline that sets the 
cut off threshold for electronic noise.  The detector is also normalized to set the proper detector voltage, 
to analyze ion response statistics and to set the proper isotope ratios. The detector normalization is also 
important for optimizing the dynamic range of the instrument. 
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About the AutoTune Algorithm  

AutoTune can be performed using different starting tune settings (stored in Tune files) at different flight 
tube voltages in both positive and negative ion modes. There are positive and negative ion mode Tunes 
available at three different flight tube voltages: 5 Kilovolts (kV), 8 kV and 11kV. The 8kV range can be used 
for most work.  For low mass work (i.e., m/z <600) the 5 KV flight tube voltage is optimal, whereas for high 
mass work the 11 KV flight tube voltage is optimal. 

The AxION 2 TOF can be operated in 2 modes: pulse mode and trap pulse mode. Trap pulse mode allows 
the user to increase the signal to noise (S/N) over a narrow m/z window. This is accomplished by setting 
the timing of two parameters in the Trap Enhancement Tab. In trap pulse mode the ions get “trapped” 
between the hexapole and the lens stack by controlling the value of the D7 voltage gate.  Setting D7 to 
longer times will allow trapping of more ions as they buildup in this region, while setting D7 to shorter 
times will result in trapping fewer ions. The second parameter is the value of D8 which ultimately controls 
which m/z region that will get enhanced. Shorter values of D8 will trap the lower mass region while 
longer values of D8 will trap the higher mass regions. For example: setting D7 to a value of 8 µsec and 
setting D8 to 22 µsec will trap in the region near m/z 130. Setting D7 to 22 µsec and D8 to about 45 µsec 
will enhance the signal to noise of ions in the range of m/z 600. D8 sets the timing for when the pusher 
puller stack will eject ions into the flight tube. Therefore, the desired mass region to be enhanced can be 
selected by setting values for D7 and D8 properly.  

How  the AutoTune Algorithm Runs 

 

An AutoTune file, TuneMethod.tofscr2, runs the following four individual scripts in the order listed 
below: 

a. DAUnormalize.tofscr2 
b. LensTune.tofscr2 
c. DetectorNormalize.tofscr2 
d. TrapPulse.tofscr2 
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Below is the list of the individual parameters that are optimized as per the scripts in the following order: 

Order of run *.tofscr2 run Parameter Set 

1 DAUnormalize.tofscr2 DAU offset 

2 LensTune.tofscr2 

Tradeoff factor for resolution increase 

PL1 bias  

Reflectron 

Offset Voltage 

Lens 1 and 3 

Lens 2 and 4 

PL1 bias  

Reflectron 

3 DetectorNormalize.tofscr2 Detector Voltage 

4 TrapPulse.tofscr2 
D7 

D8 

 
AutoTune results are stored in two Tune files that are created – one for the pulse mode and another for 
trap pulse mode. Additionally a log file (*.txt) is created that gives the detailed information of the 
parameters optimized. 

About the Samples 

Tune Mix  (PerkinElmer Part Number ZG2421A) 

Negative Mode Ions:  m/z 112.98558, 431.98233, 601.97897, 1033.98811, 1633.94978, 2233.91146, 
2833.87314 

Positive Mode Ions:  m/z 118.08625, 322.04812, 622.02896, 922.00979, 1521.97147, 2121.93315, 
2721.89483 

Calibrants  

The ESI Tune Mix (PerkinElmer Part Number ZG2421A) TOF mass calibration solution is suitable for both 
positive and negative ion tuning and mass calibration.  It is used at 100:1 dilution for positive ion mode 
and 1000:1 for negative ion mode. The dilution is made in 95/5 LC-MS grade acetonitrile/water. 

It is also recommended that caffeine (PerkinElmer Part Number MZ301236) is added to the mix for an 
additional lower mass peak in a 1:5 dilution in the ESI Tune Mix. 

• 7.6 mL of LC-MS grade Acetonitrile 
• 0.4 mL of LC-MS grade Water 
• 2 mL of ESI Tune mix 
• 40 µL of caffeine (2 mg/mL stock solution in water) 

Calibrant Delivery by Syringe Pump 

Calibrant can be introduced into the mass spectrometer by using one of the Calibrant Vials or with the 
syringe pump.  Using a Calibrant Vial is detailed below. If, instead, using the syringe pump is desired, it 
can be set as shown in the following example: 
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NOTE: When using the 500 µL Hamilton syringe, set the inner diameter to 3.26 mm and the flow to 10 µl/min.  

1. Select the Syringe Pump tab on the 
Manual Tune dialog. 

2. Select Hamilton from the Manufacturer 
drop-down list. 

3. Select 500 µL from the Model drop-down 
list. 

4. Select 3.26 from the Diameter drop-
down list. 

5. Select a 10 from the Liquid spin box. 

6. Select µL/min from the Units drop-down 
list. 

        

Preparing for AutoTune 

Typically use the Positive Ion Tune mix.     

1. Fill the syringe with the Tune Mix (PerkinElmer Part Number ZG2421A) and mount the syringe in the 
syringe pump.  

2. Connect PEEK™ tubing from the end of the syringe to the inlet of the ESI sprayer and use a PEEK 
finger tight fitting to secure the tubing as shown below to the left ESI sprayer.  

 

  

Finger tight 
PEEK Fastener 

PEEK Tubing 

Ultraspray™ 2 
Dual ESI Sprayers 



26 . AxION 2 TOF MS User’s Guide 

 

Running AutoTune 

Set you source positions before you start the AutoTune procedure. 

 

 

3. Set the source horizontal position so that the horizontal probe marking is positioned 10 spaces to 
the right side of the scale as shown below: 

 

Set the Probe Tilt position as shown below: 

 

Locations of the Source  
Setting Adjustments. 

Set the depth of the probe 
adjustment for maximum 
sensitivity. 

Set 
Horizontal 

 

Set Tilt Position Here 
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4. Double-click on the TOF MS Driver icon on the desktop. 

  

5. Select Open Manual Tune from the File menu. 

  
The Open Tune dialog displays. 

  
There are six AUTOTUNE files displayed. 

6. Select Typical Tune Pos 8kV.  
The above example shows selecting Typical Tune Pos 8kV as the Tune file. 

7. Click Open. 
The Manual Tune - Typical Tune Pos 8kV dialog opens. 
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8.  Click Apply to load the Tune.  Once loaded, the Manual Tune dialog is active. 

 

9. Click the Ion Source tab and set the RightNeb Gas or LeftNeb Gas to 80psi, depending on which 
probe is used for calibrant delivery. 

NOTE: The gas must be on when running dual sprayers. 

10. Select the Calibration Vial containing the Tune Mix and click the Apply button to activate the vial 
or turn on the syringe pump by selecting the Pump is OFF button in the Syringe Pump tab. 
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11. Click the Optics/Flight Tube tab to review the settings for Typical Tune Pos 8kV.  Then click the 
Acquisition is OFF button to turn on Acquisition. 

               

NOTE: If the instrument had been in positive ion mode for at least two hours, let the instrument pulse for one 
hour to equilibrate the electronics and hardware. If the polarity was just changed, open the Tune and 
allow the instrument to pulse for at least 2 hours before running AutoTune in the current polarity. 

12. While the instrument is pulsing, infuse the tune mix at 10µl/min into the mass spectrometer and 
make sure all seven of the calibration ions are observed while the instrument is acquiring; then stop 
the infusion. 

13. After the instrument has been given appropriate time to thermally stabilize (see Note above), close 
the TOF MS Driver program. 

14. Before going to the next step, restart the infusion of the tune mix from either the calibrant vial or 
syringe pump at 10µl/min and let it run for a few minutes before starting AutoTune to insure a stable 
calibrant flow. 

15. On your desktop, double-click on AutoTune.exe. 

 
The AutoTune application starts and displays the Select File to Open dialog. 
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16. Select TuneMethod then click Open. 
The following AutoTune screens appear. 

 

17. If necessary, in the Start Tune line, click the drop-down arrow and select Typical Tune Pos 8kV 
from the drop-down list. Also click in the check box to Display spectra. 

 

18. In the Run Script File line click Browse. 
The Select File to Open dialog appears. 
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19. Select TuneMethod then click Open. 
The following screens display. 

 

Regardless if Save Tune is checked or unchecked, AutoTune automatically saves 2 Tunes; one for 
pulse mode and one for trap pulse mode with the prefix ATfrom_with the ending either Trap or 
Pulse. 
If Save Tune is checked, AutoTune still automatically saves a Trap Tune with the prefix ATfrom_ 
followed by the name you gave it, and ending with Trap. 

20. Click Run to start the AutoTune.  
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21. In the TOF Current Proc screen, as you move 
the mouse, the pointer turns to a cross hair.   

22. First click on the left side of the target mass you 
want to tune on. Typically in positive ion mode 
select m/z 922 and in negative ion mode select 
m/z 1033. 
If you are only concerned with Trap mode, 
AutoTune on the mass that is closest to your 
target mass. If your target mass lies between 
two of the calibration peaks, choose one and 
later you can open the trap Tune and adjust the 
D7 and D8 values to optimize your trap 
enhancement while infusing your target 
compound. 

 

23. Position the cross hair to the right of the target mass.  When you click the mouse, AutoTune immediately 
starts to run. 

 
As AutoTune runs though the tuning procedure, many windows appear and disappear from the 
monitor. For example, as Lens 1 and Lens 3 are tuned, the following windows appear… 

Target mass 
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If you see the following information box dialog display.....   

 
.... the instrument tunes on the next isotope. No action is required. 

If you see an error display, this means that the Trap script did not complete. To overcome this, 
open the pulse Tune that AutoTune just created as shown on the next page and give it a different 
name. Then go back and run AutoTune again using the TrapPulse.tofscr2 script with this newly 
named Tune. 

When AutoTune is complete it will save a Tune with the prefix ATfrom with your name followed by 
Trap at the end of the Tune name. 

24. After AutoTune is complete close the AutoTune windows by clicking on the X in the upper-right of the 
TOF AutoTune screen as shown below and all of the other windows will close. 
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25. Click the red button to restart TOF services 

 

 

26. Open the TOF MS Driver. 

 

27. Open the pulse Tune that AutoTune just created. 
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28. Open the Tune in pulse mode while infusing the tune mix.  
Right click on the apex of the m/z 922 ion (in positive ion mode) and check the resolution calculated. 
The AxION 2 TOF has a resoluton specification of >12,000 at m/z 922 at 11kV flight tube voltage 
(not at 8kV, that the example above used). Always remember that there is a trade off between 
resolution and sensitivity. To achive the ultimate resolution possible requires sacrificing sensitivity!  
(Note:  In negative ion mode, the m/z 1033 ion can be used to check the calculated resoluton.) 

 AutoTune was designed to automatically achieve very good resolution, but also to balance the 
need for sensitivity. Consequently, it may not deliver resolution that meets or exceeds the 
AxION 2 instrument specification of >12,000 at m/z ~1000 (using 11kV flight tube voltage).  

 If the goal is proving that the instrument performance specification for resolution can be met, 
then typically some minor manual tuning will be required after an AutoTune to demonstrate the 
resolution specification. 

 If AutoTune provides the desired performance required by the user, then proceed to the section 
on how to perform a default calibration (associated with the specific Tune). 

 If the user requires even better performance than that which was delivered using Auto Tune, 
contact a PerkinElmer Product Specialist. 
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Calibration 

Calibration is accomplished using the AxION 2 TOF MS Driver. If Tune Mix (PerkinElmer Part Number 
ZG2421A) is to be used for the default calibration in positive ion mode, the solution should be diluted 
100:1 with 95/5 LCMS grade acetonitrile/water.  In negative ion mode, the dilution should be 1000:1 with 
the same solvent. 

To calibrate the instrument, start by opening the desired Tune in the MS TOF Driver, click the acquire tab 
and let the instrument start pulsing. If the instrument has not been acquiring data (pulsing) for some 
time, let the instrument pulse for 30-60 minutes to allow the electronics to thermally stabilize.  When 
switching polarity prior to a calibration, it is best to let the instrument pulse for 30-120 minutes prior to 
doing the calibration.  

The masses for the calibration mix in negative and positive ion modes are given below. 

About Samples 

Tune Mix  (PerkinElmer Part Number ZG2421A) 
Negative Mode Ions:  m/z 112.98558, 431.98233, 601.97897, 1033.98811, 1633.94978, 2233.91146, 2833.87314 

Positive Mode Ions:  m/z 118.08625, 322.04812, 622.02896, 922.00979, 1521.97147, 2121.93315, 2721.89483 

Calibrants  

The Tune Mix (PerkinElmer Part Number ZG2421A) TOF mass calibration mix is suitable for positive ion 
and negative ion tuning and mass calibration.  It is used at 100:1 dilution for positive ion mode and 
1000:1 for negative ion mode. 

It is also recommended that caffeine (PerkinElmer Part Number MZ301236) is added to the mix for an 
additional lower mass peak in a 1:5 dilution in the ESI Tune Mix. 

• 7.6 mL of LC-MS grade Acetonitrile 
• 0.4 mL of LC-MS grade Water 
• 2 mL of ESI Tune mix 
• 40 µL of caffeine (2 mg/mL stock solution in water) 

Calibrant Delivery by Syringe Pump  

Calibrant can be introduced into the mass spectrometer by using one of the Calibrant Vials or with the 
syringe pump.  Using a Calibrant Vial is detailed below.  If, instead, using the syringe pump is desired, it 
can be set as shown in the following example: 

NOTE: Using a 500 µL Hamilton syringe, set the inner diameter to 3.26 mm with a flow rate of 5 to 10 µL/min. 
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1. Select the Syringe Pump tab on the Manual Tune 
dialog. 

2. Select Hamilton from the Manufacturer drop-down 
list. 

3. Select 500 µL from the Model drop-down list. 

4. Select 3.26 from the Diameter drop-down list. 

5. Select a value between 5 and 10 from the Liquid 
spin box. 

6. Select µL/min from the Units drop-down list. 

 

 

After the instrument has stabilized, while acquiring, infuse the tune mix.  Examine the spectra to make 
sure that all of the target masses are present.  Adjust the probe needle depth, horizontal position and the 
tilt for the single probe sprayer as shown below. If you are using a dual probe sprayer make sure that 
both probes are inserted into the source.  

For the Dual ESI source, connect the infusion line to the left hand side of the dual sprayer. (The left 
sprayer is recommended since it must be used when the lockmass calibrant is infused simultaneously 
with the LC effluent.) The probe needle depth and the tilt positions should be the same as for the single 
probe sprayer but the horizontal position may have to be adjusted to optimize the sensitivity of the 
calibration mixture.  

 

1. Set the source horizontal position so that the horizontal probe marking is positioned 10 spaces to 
the right side of the scale as shown below: 

Locations of the Source Setting Adjustments. 

Set the depth of probe adjustment 
for maximum sensitivity. 
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Set the Probe Tilt position as shown below: 

 

2. To start the calibration, double-click on the TOF MS Driver icon. 

 

3. From the File menu, open Manual Tune. 

 

4. Select the Tune you want to calibrate by scrolling to the Tune then click on it to open it.  
In this example, we have selected the Tune: ATfrom_Typical Tune Pos 8kV 

 

Set 
Horizontal 

 

Set Tilt Position Here 
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5. Click Open. 
The Manual Tune - ATfrom_Typical Tune Pos 8kV dialog displays. 

6. If using a calibrant Vial to introduce Tune mix, update the drop-down to choose the appropriate 
Calibrant Vial.  Then click Apply to apply the Tune and turn on the pump for the appropriate 
Calibrant Vial.  If introducing Tune Mix using the syringe instead of the calibrant vial, Apply the tune 
and then select the Syringe Pump tab and select the Pump is OFF button. 
The instrument loads the Tune. 

  

7. Click on Acquisition is OFF button to turn the acquisition on. 

  
The TOF will start pulsing and the Acquisition is OFF button will light up green and change to 
Acquisition is ON. With the acquisition on, allow the electronics to thermally stabilize as describe at 
the beginning of this Section.  
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Make sure the Drying Gas Flow is set between 6-8 (l/m), the Drying Gas Heater to 300 C, the 
Endplate Heater is OFF and the Nebulizer Gas for the probe introducing the tune mix is set to 80 
PSI. 

 

8. From the Calibration menu select Configure to open the TOF Mass Spectrum - Configuration 
Calibration window. 

  

9. Select the ion Polarity (Positive or Negative) and check the masses for the calibration series by left 
clicking in the boxes under In Use column.  

The example above shows that we are calibrating on seven masses.  To enter, edit or delete a value 
in the calibrant mass list, right click on the list of compound/masses and choose the appropriate 
menu item.  Validation checks the entry selected is within acceptable mass specifications. 

10. Use 30 for the No. Spectra to Average and use the value 3 for the Minimum S/N. The Search 
Span should be set to 2 amu; however if the masses are off more than 2 mass units you will have to 
open the span wider. The Polynomial Order should be 2 but if this does not work well you can set 
the order to 1 or 3 and rerun the calibration.  

11. Click OK to set these values. 

12. In the Manual Tune dialog, click on the Calibrate button and allow the calibration to complete. 
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When the calibration is finished the calibration window will appear. 

 

13. Click the Show Stats button. 
The information appears on the bottom half of the screen. 
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14. Make sure the Residuals are less than 0.000x as shown above (there should be three zeros for each 
of the Residuals). Click the Accept button. 

15. If all of the Residuals are less than 0.000x as shown above, select Save from the File menu. 
This ties the calibration information to this Tune file. 

  

16. If any Residuals are too high, as shown in the following example, perform the following procedure to 
adjust the residuals to an acceptable level. 

 

a. Left-click and drag the mouse to draw a box around the mass and the calibration line. 
The following example shows the mass and calibration line close to each another. 
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After drawing the box, release the mouse button and the Zoom pop-up box appears. 

 

b. Select Zoom X-axis or Zoom X-Y axis.  Continue to Zoom in by redrawing a box until 
the mass and the calibration line are visible as shown below. 

 

c. Left-click on the calibration line and drag it to the center of the mass peak as shown 
below. 

Calibration Line 
Mass 
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Repeat this procedure for all masses where the Residual is greater than 0.000x. 

d. Click the Recalculate button and observe the Residuals to make sure they are within 
specification. 

 

e. To complete the calibration procedure, click the Accept button. Then from the TOF MS 
Driver window, select Save from the File menu. 

17. If this procedure fails, increase the concentration of your calibration mix. 
 For the Tune Mix in positive ion mode, change it from 100:1 to 50:1. 
 In the negative ion mode, change concentration from 1000:1 to 100:1  
 Then rerun the calibration procedure. 

When the calibration is complete, apply the Pulse Tune calibration to the Trap Tune that AutoTune 
created.  

18. Open the Trap Tune. 

19. On the Manual Tune dialog, click the Trap Enhancement tab and write down the values for 
D7 and D8. 
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20. Open the calibrated Pulse Tune and select Trap as the Acq. Function.  Then click the Trap 
Enhancement tab, click the Manual check box, type the values for D7 and D8 that you wrote down 
in the previous step. 

 

21. Then from the TOF MS Driver window, select Save as from the File menu and save the file as the 
Trap Tune.  Now the calibration is applied to the Trap Tune. 
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Ramping the AxION 2 TOF MS 
Capillary Ex it 
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Setting up a Sample Infusion 

To optimize a specific variable, it is typically necessary to infuse a continuous amount of sample into 
the ion source. There are 2 ways to accomplish this, infuse the standard at a low flow rate directly into 
the MS, or infuse it into the LC stream running at a typical flow rate in order to also optimize “flow 
dependent” MS parameters such as temperature and drying gas. The following example demonstrates 
how to infuse a reserpine standard directly into the MS using a syringe. Reserpine was chosen because 
it is a widely used standard in the LCMS community and it is readily available from a variety of 
commercial sources. 

1. Fill a syringe with a ~50 pg/µl reserpine solution in LCMS grade methanol and water in a 75:25 ratio 
in 5 mM ammonium formate 

2. Since this example demonstrates a dual-probe system, connect a Peek transfer line from the syringe 
needle to the left ESI sprayer. (Either sprayer may be used if infusing a solution.) 

3. With the syringe prepared for infusion, the next part of the process covered in the next section 
involves ramping (to optimize) the capillary exit voltage. 
 

 

Connect 
Capillary Tubing 
to the Probe 
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Ramping Parameters - Optimizing the Capillary Exit Voltage  

The AxION 2 TOF MS driver allows you to ramp certain Tune parameters to determine the best settings 
for those parameters. However, the AutoTune routine has eliminated the need to do this except for the 
one parameter that is “compound dependent”, the Capillary Exit voltage. This is the one parameter that 
should be checked in order to obtain the best sensitivity for quantitative analyses, or minimize or 
maximize molecular fragmentation information for qualitative analyses, or both.  

To Ramp the Capillary Exit voltage: 

1. Open a Manual Tune. 

2. When using a dual sprayer, click on the Ion Source tab and turn on the appropriate Calibrant Vial as 
previously described. 

 

3. Start infusing your target compound (in this example it is reserpine) into the probe on the left. 

 
Observe your target mass (in this example reserpine) in the TOF Driver window. 
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4. In the m/ z  screen, right-click on the apex of the target mass and write down the observed values. 

  

NOTE: The above window shows the observed value of m/z 609.2716. 

5. Click Close. 

Reserpine peak 
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6. In the TOF MS Driver screen, select BIC from the View menu. 

 
The Base Peak Preferences dialog displays. 

 

7. Type a Start m/ z value to the left of your target peak and an End m/ z value to the right of your 
target peak.  Select Amplitude for the Trace Selection and Replace Curves for the Display. 

8. Click OK. 
The BIC screen displays. 
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9. Stop acquiring by clicking the green Acquisition is ON button.  The button changes to Acquisition 
is OFF. 

10. Select the Ramping tab.  The Acquisition is OFF button changes to Ramping is OFF. 

 

11. Select or enter values for the following: Item to Control, Ramping Parameters, and Steps. 
In this example we entered the following:  

Function Parameters Values/Settings 

Item to Control Page Optics 

 Control Capillary Exit 

Ramping Parameters Start 100 

 Stop 250 

 Increment 5 

 Units Volts 

Steps Spectra Per 1 

12. To start the ramp, click on the Ramping is OFF button. 

It turns green and changes to Ramping is ON   

13. When the ramp completes, right-click in the BIC screen and select Mark Data Points from the pop-
up menu. 
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The Ramp marks the data points as it runs to completion. 

 

14. Start counting the data points from the left side of the BIC screen to the apex of the displayed peak. 
Each data point is 5 volts (V); this is the value you entered as an Increment in the Ramping 
parameters. In this example we counted 12 data points. 

 

15. Multiply the counted number of data points (12) by the voltage per data point (5V) 12x5=60. Add 
this 60 value to the Ramping Parameters Start Mass value, in this example the Start Mass value 
is 100.  100+60=160.  This value is now your optimum Capillary Exit voltage for reserpine. 

16. Click on the Optics tab.  Enter the above calculated value of 160 as the Capillary Exit value. 

12 Data points 
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17. Select Save Tune from the TOF MS Driver File menu. 

18. Turn the acquisition on and view you spectrum in the Mass screen. 

Ramp Again to Optimize the Signal Intensity of a Fragment Ion 

Obtaining fragmentation information on a compound can be very valuable for a number of reasons. It 
gives insight into the structure of the compound, which is typically applicable to other compounds with 
the same base structure (e.g., drugs and their metabolites). It also provides additional ions associated 
with the analyte that can be measured instead of, or in addition to, the protonated molecular ion. For 
example, in quantitative analyses, there is occasionally an issue with a contaminant or mobile phase ion 
at the same nominal mass as the analyte to be measured. This may have a significant effect on the 
detection limits of the analyte due to background noise. To overcome this, fragments of the analyte can 
be monitored instead of, or in addition to, the protonated molecular ion. The probability of the interfering 
ion having a fragment at the same m/z value as a fragment from the analyte is extremely low (but still 
must be verified!) 

The following screen shows reserpine optimized at 160V. 
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1. To view the fragment, increase the Capillary Exit value (in this example we set it to 250V) and click 
Apply. 

 

2. Increase the Capillary Exit value (in this example we set it to 300V) and click Apply. 

Reserpine parent intensity 
before applying the higher 
capillary exit voltage (250V). 

Main fragment ion at 250V. 
Right click on the apex of the 
most intense fragment ion. 
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3. In the m/ z  screen, right-click on the apex of the most intense fragment ion(s) observed and write 
down the observed values. 

 

NOTE: The above window shows the observed value of m/z 195.0641. 

4. Select BIC from the TOF MS Driver View menu. 
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The BIC Base Peak Preferences dialog displays. 

 

5. Type a Start m/ z value to the left of your target peak and an End m/ z value to the right your 
target peak.  Select Amplitude for the Trace Selection and Replace Curves for the Display. 

6. Click OK. 

7. Stop acquiring by clicking the green Acquisition is ON button.  The button changes to Acquisition 
is OFF. 

8. In the Manual Tune dialog, select the Ramping tab. 
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9. Select or enter values for the following: Item to Control, Ramping Parameters, and Steps. 
In this example we used the following settings:  

Function Parameters Values/Settings 
Item to Control Page Optics 

 Control Capillary Exit 

Ramping Parameters Start 160 

 Stop 300 

 Increment 5 

 Units Volts 

Steps Spectra Per 1 

10. To start the ramp, click on the Ramping is OFF button. 

It turns green and changes to Ramping is ON   

11. Right-click in the BIC screen and select Mark Data Points from the pop-up menu. 

12. After the ramp is complete as shown in the previous example, start counting the data points from the 
left side of the BIC screen to the apex of the displayed peak. 
Each data point is 5V; this is the value you entered as an Increment in the Ramping parameters. 

13. Multiply the counted number of data points by the voltage per data point (5V). 

14. Click on the Optics tab.  Enter the above calculated value as the Capillary Exit value. 

15. Select Save Tune from the TOF MS Driver File menu. 

16. Turn the acquisition back on and view you spectrum in the Mass screen. 
 

 



Creating Methods and Sequences  
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Creating an MS Method 

The foundation for an optimal MS Method is starting with a good mass calibrated Tune. Using the 
previous calibration instructions, ensure the tune is proven to be optimized, using Calibration, before 
proceeding.  

The following example shows how to create an MS method that will acquire both a total ion 
chromatogram (TIC) and an extracted ion chromatogram (EIC), along with the spectra. While the TIC 
gives an indication of the sum of the ion intensities observer during a scan (written to disk), the EIC is 
used to selectively identify specific masses in real time to indicate when they are observed within a scan. 
This is extremely valuable for quantification purposes, since the protonated molecular ion (in positive ion 
analyses) of a molecule or fragment thereof, may be quantified within a batch of samples containing the 
appropriate calibration standards.  

IMPORTANT: If quantification of a compound using Chromera is desired, then the EIC masses of the ions of 
interest must be predefined in the TOF MS Driver Method in order to be available to Chromera 
for processing.  EICs added post-acquisition are invalid for reprocessing. 

To create an MS method: 

1. Click Method to open the Chromera Method screen. 

 

2. Select Create/Edit MS Method/Tune from the File menu. 

 
The Method Editor screen displays in the TOF MS driver screen. 
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3. Click and drag the red bar in the graph to set the time of the experiment to the same time required 
for the previously developed LC method.  Addition time periods can be added by selecting Add Time 
Period in the Method menu.  Also, existing data (.tofdata2) can be loaded as an overlay to aid in 
assignment of multiple time periods. 
In the above example, it is set to 5 minutes. 

4. Select a Tune from the drop down list or by selecting the Browse Tunes… button, then double-click 
on the Tune name.  As soon as a tune is assigned to a method, the parameters for the tune are 
written into the method file (tofmethod2). 
This example shows ATfrom_Typical Tune Pos 8kV was selected.  This example also shows the 
addition of a second time period and the overlay of a tofdata2 file. 

 

5. Select whether the tune parameters from the Database or the Method File will be used.  The 
Database selection means that later updates to the parameters of that tune (through Manual Tune,  

Red Line 
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Autotune and/or Calibration) will automatically be used when the method is run.  This occurs without 
re-associating the tune to the method.  In contrast, the Method File selection keeps the tune 
parameters static.  The Database option is recommended and the default selection for new methods 
and for methods created using earlier versions of the TOF MS Driver software. 

NOTE: If, during acquisition, a method is configured to use a tune stored in the database but that tune name is 
not found (renamed or deleted), the system will automatically use the tune parameters in the method 
file.  Also, if a method file is set to read only then the functionality to pull the tune from the database is 
not functional. 

6. The peripheral device settings in the lower part of the screen are method and time period specific.  
These specific settings in the method will be used over the tune settings during acquisition and when 
the TOF Driver method is loaded into Chromera to get to Operate mode. 

a. Only those parameters shown below can be changed at the method level. Consequently, 
be very careful with the Method File option for fetching the Tune Parameters.  With this 
selected, the peripheral values that cannot be set within the method are also static.  For 
example, the syringe TYPE.  If a method uses the Method File tune parameters and the 
syringe TYPE is changed in the tune, that change is not adopted during method-
controlled acquisition.  The Database option for fetching tune parameters will adopt 
such changes. 

 

IMPORTANT:  For processing in conjunction with Chromera, ALWAYS have “Save spectra to disk” selected. 

7. Define EICs:  In the Evaluation section of the Method Editor screen, click the Load button. 

The following dialog displays. 

 
The EIC values entered here will be displayed in real time during acquisition in Chromera and will be 
available for quantitation in Post Run. Edits to the EIC list cannot be applied to acquired data. 
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8. Click the Insert key on your keyboard and enter the EIC value in m/z; with this example it is 
195.0877 for protonated caffeine.  

9. The Tolerance (+/-) of the EIC can be selected in parts per million (ppm), millimass units (mmu), or 
m/z as in the Selection section; here, mmu was used for the EIC tolerance with a value of 10 
millimass units. Make sure to press the Enter key on the keyboard to update the method with this 
value. 

NOTE: The resolving power and exact mass measurement capabilities of the AxION 2 TOF provides a 
tremendous amount of selectivity that should be utilized to the user’s advantage. Entering an EIC mass to 
4 decimal place accuracy and specifying a tolerance of a few mmu (or ppm) will significantly increase the 
selectivity of detection for the specified analyte.  

10. Click the Save button (to save the EIC for future use). 
The following Save As dialog displays. 

 

11. Type a File name. 
In this example, the name is Caffeine EIC. 

12. Click the Save button. 

13. Apply Lockmass Parameters:  In the Calibration section of the screen, select Default or Lockmass 
from the drop-down. 
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In this example we selected the Default Calibration setting which uses the calibration that was 
updated within the selected Tune (by utilizing the Calibrate button on the Tune page).   
Alternatively, two Lockmass values can be assigned to be used for mass correction during acquisition.  
Parameter sets can be saved for future use.  Refer to the next section for additional information. 

14. To continue, click Save from the main File menu on the TOF MS Driver window. 
The Save As dialog appears: 

 

15. Type a File name, then click OK.  To use a method in Chromera it must be saved in 
C:\ProgramData\PerkinElmer\AxION\Method. 
In this example the name is DemoMethod.tofmethod2. 

Using Lockmass in Real-Time 

These instructions can be used to create LC-TOF methods using Lockmass calibration in real-time. For a 
complete guide on setting-up on-the-fly lockmass, refer to the last section of this manual. 
For Lockmass calibration runs, ideally it is better to infuse calibrant continuously in the left probe in the 
dual ESI source while the other ESI probe will be connected to effluent from the LC. Lockmass 
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calibration runs may be done with single probe ESI source also, but in this case, both the eluent from LC 
and the calibrant from a syringe pump must be connected to a tee before connecting it to the ESI 
sprayer. 
The advantange of analytical runs with lockmass calibration done in real-time is that the mass 
measurement accuracy can be improved to 2 ppm (or sometimes better, depending on the mass 
measured and the flight tube voltage) even with small drifts in room temperature during the course of 
the analyses.  

1. From the File menu on the TOF MS driver window, main menu, select New Acquisition Method.  

2. Select a TOF Tune with the desired scan range and rate that contains a recent calibration.  
The Method Editor window will look similar to the following: 

 

Choose two Lockmasses from your calibration solution, which will typically be infused into the 
second (left) ESI sprayer of the Ultraspray 2 ion source. Ideally, the masses of the target compound 
sample should be between the two lock masses. In this case for reserpine (m/z 609.2) as the target 
compound, the two masses for calibrants entered would be 118.08625 and 922.00979 u. 

3. In the Calibration section of the screen, select Lockmass from the drop-down, then click on the 
Enter Lockmass button. 

4. Type in the desired mass values in the Lockmass Calibration window; these can be saved for 
future reference by clicking the Save button.  Selecting OK will associate the configuration (saved 
or not) to the method. 
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5. Choose a suitable name for the lock mass preferences and click Save: 

 

6. Saved lock mass values can be retrieved by clicking on Load and selecting the desired lock mass 
preference file and clicking Open: 

 

 

7. Click OK to update the method. 
The screen displays with lock masses as 118.086 and 922.010. 
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8. Save the above method. This setup can be used for performing on-the-fly lockmass. 

NOTE: If a method is configured to apply lockmass calibration but the system does not find the peaks, the 
system will revert to using the default calibration in the tune.  Batch Convert can be used to apply 
different lockmass parameters in the case, for example, the wrong mass was originally specified. 

9. Close the TOF MS Driver window. 
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Creating a Chromera Method 

After creating the MS method in the TOF MS Driver application, open Chromera to create a Chromera 
method. The Chromera method will define all the operating requirements for all the other components in 
the Chromera configuration. 

To create a Chromera method: 

1. Click Method to open the Method screen. 

 

2. Select New Method from the File menu. 

 

3. Type a Method Name and a Group.   
Optionally, you can also enter a Description. 
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This example shows a Method Name of TOF Demo and a Group of TOF Group. 

 

4. Select Save Method from the File menu. 

5. Enter your instrument parameters by clicking on each instrument. 
Click on FX15Pump-1 and enter the pump parameters. Click Gradient to specify a step-wise buffer 
method or Isocratic and the Advanced checkbox, as appropriate for the chromatographic run 
conditions.  The pump protocol will drive the totally processing time for the method. 

IMPORTANT:  Be sure Run Time Reconciliation is checked. 

 

6. Navigate to the autosampler parameters section. Click Advanced to show additional autosampler 
parameters.  Update those parameters as necessary to the instrument configuration.  Injection 
volume specified here will be automatically applied when the Sequence of runs is defined. 
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7. Navigate to the AxION TOF section in order to link the MS Method previously defined in the TOF 
driver software to the Chromera method being defined. 

 

8. Click Browse for Method. 
The Select Method dialog displays. 
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9. Select the method you created in the TOF MS driver in C:\ProgramData\PerkinElmer\AxION\Method, 
then click Open.  The system will load the EIC information stored in the TOF method into the 
Chromera method. 
This example, below, shows the association with DemoMethod.tofmethod2 

NOTE: There is a known issue, as of TOF Driver version 6.2, with the display of the total run time of the TOF 
acquisition method in Chromera.  When multiple time periods are configured in the TOF method, the total 
run time displayed in Chromera only accounts for one time period.  To resolve this issue, the run time 
reconciliation done when the Chromera method is saved will give the user the option to extend the TOF 
run to the total defined pump run. 

 

 

10. Select Save Method from the File menu.  The Run Time Reconciliation will ask if the TOF method 
run time should be extended.  Select the Yes button. 

 

Imported EICs Assigned TOF Method 
time before reconciliation 

 

Assigned TOF Method 
time after reconciliation 
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Creating a Chromera Sequence 

After creating a Chromera method, create a simple Chromera Sequence to run the method. 

To create a Chromera sequence: 

1. Click Sequence to open the sequence screen. 

 
The Sequence screen opens with the last run sequence displayed. 

2. Select New Sequence from the File menu. 

 
A blank sequence screen displays. 

3. Set the sequence identifiers. 
• Click in the Name box and type a name for this sequence. 
• Select the Group from the drop-down list.  
• Select the Sample Tray Type of your autosampler.  This example shows 100-Position 

Tray. 

 

4. Enter the Sequence Parameters. 
• Select the Sample Type from the drop-down list.  This example shows Sample. 
• Type a Sample Name.  This example shows DemoBlank. 
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• Type the number of Injections.  This example shows 1 injection. 
• Type the Injection Volume (µL).  This example shows 5.0 µL. 

 

5. Select the Method for this sequence by clicking the button  in the Method field. 

6. The Data Selector – Single Method dialog displays.  Click the plus sign  to expand the 
appropriate Method Group 

 

7. Click in the Select box to select the method.  This example shows DemoMethod is selected. 

8. Click Open to insert this method in the sequence. 

9. Click the plus sign  to display additional run parameters. 

 
You can enter more parameters or save what you entered to this point. 

10. Additional runs added to the Sequence will inherit the values of the run before it. 

11. Select Save Sequence As... from the File menu. 

 

12. If not auto-populated, type a sequence Name and select a sequence Group from the drop-down list. 
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13. Click OK. 
 
 

 
 



Starting Data Acquisit ion 
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Preparing for an Analysis 

Prepare the system with mobile phase, a column, and the sample listed below for the example analysis. 
The analysis conducted for the example shown on the following pages utilizes an isocratic HPLC method. 

• Mobile Phase:   A: Methanol; B: 50/50 Methanol/Water  

• Sample:  50pg/µL caffeine 

• Column:  3x3 CR C18 column and column holder 
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Equilibrate the System 

Before running an analysis, the LC system and the TOF must be equilibrated to achieve a stable 
chromatographic baseline and to properly condition the LC column. 

To equilibrate the system: 

1. In Chromera click Run Time then click Manual Control for the Control Mode. 

 

2. In the Operate row, click Browse for a TOF Method. 
The Select Operate Method dialog displays. 
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3. Select the method (in this example DemoMethod.tofmethod2) and click Open. 
The selected method displays in the Method file name field. 

4. In the Operate row click Apply.  The settings for the initial time period of the TOF method will be 
loaded. 

NOTE: The mass accuracy of a TOF MS (running without lockmass) is very much dependent on the thermal 
stability (i.e., temperature equilibrium) of the system. If ion polarity has not been switched, the TOF 
should be allowed to pulse over the desired mass range for at least 30 minutes prior to calibration (the 
best results are obtained with 60-120 minute equilibration time). After calibration, the analyses to be 
performed should be run as soon as possible to avoid “cooling off” of the flight tube and electronics. If 
the samples cannot be run immediately after a calibration, the TOF should be left pulsing to keep it 
thermally stable. If the analyzer’s polarity is switched, the instrument should pulse for 2 hours before 
running a calibration. 

5. Make sure the chromatographic tubing is connected between the LC system and the AxION 2 TOF MS 
detector. 

6. Enter Pump Settings and click Apply to start the pump. 
In this example, enter a 1.0 mL Flow, 5% A, and 95% B. 

7. Set the autosampler Peltier Tray temperature, if applicable.  Enter the target temperature and 
tolerance and click Apply to ramp to target. 
In this example, enter 20°C Target with a ± 2.0 °C Tolerance. 

8. Monitor the parameters in the Status Panel.  Right clicking on the Status Panel Header will bring up 
a menu.  Status Dialog can be selected and additional parameters added or removed from the panel. 
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Running a Sequence 

Once the system has reached equilibration, you can load and run the sequence.  This example shows a 
simple sequence. 

To run a sequence: 

1. Select the Run Time Group and the Sequence radio button 

 

 

2. Select Open Sequence from the File menu. 

 
The Data Selector – Single Sequence screen displays. 

 

3. Click the plus sign  to expand the appropriate Sequence Group. This displays all sequences 
saved in this group. 
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4. Click in the Select box to select the sequence.  This example shows the Sequence named 
DemoSequence is selected.  Then click Open to open this sequence. 

The sequence displays and is ready to run, indicated by the green Start button. 

 

5. Click on the green Start   button.  The sequence starts to run. 

The running sequence is displayed as a green line.  The  Total Ion Chromatogram  or TIC, which is 
the sum of intensities for all ions observed in each scan is is displayed as a black line, and the EIC of 
m/z 195.13 is displayed as a blue line. 

6. Observe the Plots pane on the left side.  Click the plus signs to expand the plots. 

 
When the run completes the display clears.  You can review the results in Post Run. 
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Running a Chromera Internal Calibration 

An internal standard is a chemical substance that is added in a constant amount to samples, the blank 
and calibration standards in a chemical analysis. This substance can then be used for calibration by 
plotting the ratio of the analyte signal to the internal standard signal as a function of the analyte 
concentration of the standards. This is done to correct for the loss of analyte during sample preparation 
or sample inlet. The internal standard is a compound that is very similar, but not identical to the chemical 
species of interest in the samples, as the effects of sample preparation should, relative to the amount of 
each species, be the same for the signal from the internal standard as for the signal(s) from the species 
of interest in the ideal case. This ratio for the samples is then used to obtain their analyte concentrations 
from a calibration curve. The internal standard used needs to provide a signal that is similar to the 
analyte signal in most ways but sufficiently different so that the two signals are readily distinguishable by 
the instrument.  

The Calibration View is used for viewing and interpreting calibration curves generated from the 
measurement of your standard solutions. The Calibration View allows you to evaluate the quality of the 
calibration by viewing both the graphic plot of the calibration points and by reviewing statistical 
information on the curve fit. You can also evaluate the effect of eliminating individual calibration points or 
replicates and changing the origin treatment.   

In the calibration graphs the results from each replicate injection is plotted and not the average. This also 
means that the ability to exclude a calibration point will mean exclusion of a single replicate and not an 
entire level. You are able to select whether each replicate is included in the calibration curve using the In 
Use checkbox displayed for each replicate. 

The Calibration section contains three tabs (Summary, Detail, and Setup Standards). The Summary tab 
shows thumbnails displays of the curves for all components/species; for all detector devices or a single 
device, depending on the method tree selection. The Detail tab shows details of the calibration for a 
selected component. Double-clicking on a curve on the Summary tab will cause the Detail tab to be 
displayed with that component selected. The Set Up Standards tab provides an easy approach to 
creating standards and entering standard amounts for all components.  

The following example shows how to create and run an internal calibration in Chromera: 

1. Start by creating a Chromera method. 
In this example, the method is named Internal Standard and the Group is named Calibration. 
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2.  In the Peaks tree select a channel for your internal standard. 
In this example, we selected the channel 14 PER(0:300150)PEIC(197:897… and appears in the 
Channel Name field. 

 

3. Type a Component name. 
In this example, 13C3Caffeine. 

4. Click the plus sign to the left of Caffeine to display additional fields. 
The Type and Reference Peak fields display. 

 

5. Select Uses an Internal Standard from the Type drop-down list. 

6. Select a reference peak from the Reference Peak drop-down list. 
In this example, 13CECaffeine (TOF-3/14...) was selected. 
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7. In the Calibration tree select a channel for your calibration data. 
In this example, we selected the channel 14 PER(0:300150)PEIC(197:897… 

 

8. Click on Set Up Standards tab. 
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9. Click in the Units field and select ppm from the drop-down list. 

 

10. Add a new standard column by right clicking and selecting Add a Standard. 

 

11. Type a standard name. 
In this example, 0.2.  Do this for each of the standards (0.5, 1.0, 5.0., and 10). 
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12. Enter your internal standard of 2 in each field. 

 

13. Now for the Caffeine component enter 0.5, 1.0, 5.0., and 10 into each column. 

 

14. Select Save Method from the File menu. 
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15. Click on the Reprocess button in the lower-left pane; then select Open Data from the File menu. 

 
The Data Selector displays. 

16. Select the batch that you want to analyze. 
In this example we selected Internal Calibration. 

 

17. Click the Open button. 
The Batch Copy Selection box appears requesting if you want to create a new batch. 

 

18. In this example we clicked Create a New Batch. 
The new batch displays. 

19. Click in Sample Type field and select Calib. Replace. 
You are replacing to reset your calibration curve. 
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20. Select Calib. Ave. 
One run is a replace and the other run is an average. 

 

21. Click in the Method column, then right-click and select Fill Down. 
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22. For the Caffeine0.2ppma sample, click in the Standards column, click on the drop-down, and 
select 0.2 from the list. 
This drop-down contains a list of the standard you defined earlier in the Set Up Standards screen. 

 

23. Repeat this process by selecting the standard that corresponds to each sample name. 
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24. Click on the green Start   button to start reprocessing. 

 
As reprocess runs the row being reprocessed is shown in green. 

25. When complete, click the Method button in the navigation pane then click the Summary tab. 
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26. In the Calibration tree, select 15 PER(0:300150)PEIC(194:887... 

 

27. Click the Detail tab to display the calibration curve on the bottom of the screen. 
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28. For more detail click the plus sign to the left of the Component Caffeine. 
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Running a Chromera External Calibration 

The Calibration View is used for viewing and interpreting calibration curves generated from the 
measurement of your standard solutions. The Calibration View allows you to evaluate the quality of the 
calibration by viewing both the graphic plot of the calibration points and by reviewing statistical 
information on the curve fit. You can also evaluate the effect of eliminating individual calibration points or 
replicates and changing the origin treatment.   

The following example shows how to create and run an external calibration in Chromera: 

1. Start by creating a Chromera method. 
In this example, the method is named External Calibration and the Group is named Calibration. 

2. Click on Peaks and select a channel to define your Component and Retention Time. 

 
In this example we defined the component as Caffeine and a retention time of 2.524 min. 

3. In the Calibration tree, select a channel, then click the Detail tab. 
In this example we selected, 9 PER(0:300150)PEIC(194:887:195:287),0.2,100... 
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4. Click on Set Up Standards tab then click in the Units field, and select ppm from the drop-down 
list. 

 

5. Click the Detail tab and add the Standard Names corresponding to the Amount. 
In this example we added S1 (0.500000), S2 (1.000000), S3 (5.000000), and S4 (20.000000) 

 

6. Save the method by selecting Save Method from the File menu. 
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7. Now that your method is created and saved, we will reprocess the data using this method.  Click the 
Reprocess button in the lower-left pane. 

 

8. Select Open Data from the File menu. 

 
The Data Selector displays. 

 

9. Select you data from the list and click Open. 
In this example we selected CustomBatch.  
The Batch Copy Selection box appears requesting if you want to create a new batch. 

 

10. In this example we clicked Create a New Batch. 
The new batch displays.  In this example it is named CustomBatch. 



Starting Data Acquisition.  95 

 

11. Click in the Method field. 

 
The Data Selector opens. 

 

12. Select the method from the list displayed in the Method Group. 
In this example it is External Calibration.  

13. Right-click on the method and select Fill Down from the pop up box. 
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The method is associated with all rows to reprocess. 

14. Click in Sample Type field and select Calib. Replace from the drop-down list. 
You are replacing to reset your calibration curve. 

15. In the next row select Calib. Ave from the drop-down list. 
In this example, one run is a replace and the other run is an average. 

 

16. Enter your Standard for each sample row you will reprocess. 
In this example we did this for S1, S2, S3, and S4. 
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17. Click on the green Start        button to start reprocessing. 

 
As reprocess runs the row being reprocessed is shown in green. 
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18. When complete, click the Method button in the navigation pane then click the Detail tab. 

 
 



 

Analyze Results in Post Run 
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View ing the Results in Post Run 

Whether reprocessing existing data or acquiring new data, the completed samples will be displayed in the 
Post Run environment, and can be inspected by navigating through the Sample tree and interacting 
graphically with the chromatographic display.  

• Data can be treated as view only from the standard Post Run display. 

• Individual results can be optimized graphically. 

• The current version of the method can be graphically modified (GME, Graphic Method Editing) using 
the selected sample data.  

• Data can be viewed in Single Plot mode, Stacked Plot mode, Matrix mode for multiple channels 
and replicate injections, or in Overlay and 3D mode (3D mode is only available for PDA data at 
present). 

To view results in Post Run: 

1. Click the Post Run button in the navigation pane. 

 
Last run results are displayed or previously stored data can be loaded by selecting Open Data from 
the File menu.  Note that in the screenshot below, Chromera is being run in Data Only mode.  This 
functionality works the same way when the instrument system is connected. 

 

 

This displays the Data Selector.  Search and select the data you want to analyze then click Open. 

 

2. Click on TIC or EIC in the Data tree. 
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In this example, TIC data are displayed in the Results pane. 

 

3. Click on Scan. 
The TIC (Total Ion Chromatogram) is displayed in the top plot window and the TIC chromatographic 
data are displayed in the Results pane. 

 

4. Move the mouse pointer to the apex of the peak (it turns to a hand) at retention time ~1.0 min. and 
then right-click. 

5. Select Examine Mass Spectra from the menu. 
The spectrum from the selected retention time opens in the lower portion of the TOF MS driver 
window, and a copy of the TIC is displayed in the top portion of the window. 
Another way to enter the mass spectral processing domain (demonstrated on a different data file) is 
to select Examine Spectra from the Chromera Actions menu. 
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The spectra open in the TOF MS driver window. 
The TOF MS driver window displays a Total Ion Chromatogram (TIC) in the upper half of the 
window. If the mouse was right-clicked in the Chromera chromatogram (as in the first example 
above), the spectrum from that retention time will be displayed. If no point in the Chromera 
chromatogram is selected, then the first spectrum from the acquisition will be displayed. 
The TIC is a chromatogram where each data point represents the sum of intensities of all the ions 
detected for a scan.  Consequently, each data point in a TIC has a scan associated with it. The TIC 
mirrors a typical chromatogram displayed in an LC analysis.    
However, "all ions" are only those that were within the sampled mass range, which was determined 
by the Method used for the data acquisition and the Tune contained within that Method.   

6. Move the mouse pointer to the apex of the m/z 195.13 peak (it turns to a hand) then right-click to 
display the peak table on the bottom of the window.  
The peak table provides some statistical data on the identified peak including absolute intensity, the 
peak width, etc. 
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7. If you choose more decimal places, in the TOF MS driver window, select Annotation from the 
View menu. 

 
The Chromatogram Annotation dialog displays. 

 

8. Type 5 for Decimal places then click OK. 
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Applying Calibration in Post Run Analysis 

Improved mass accuracy on data that was acquired using a default calibration (associated with the Tune) 
can be obtained in post-run analysis by using lockmass. However, known lockmass ions must be present 
in each spectrum in order to utilize this capability.  Multiple files can be processed at once using Batch 
Convert or files can be re-analyzed separately.  This process creates a new .tofline file so, if an original 
exists and is in the same folder as the .tofdata2 file, it will be overwritten.  Be sure the .tofcal2 is also 
available. 

1. In the , select Batch Convert from the File menu. 

 
Multiple types of Calibration Modes can be applied. 

a. Existing: Retrieves the Calibration configuration used for the initial acquisition and re-
executes calibration using those parameters.  The tofcal2 file generated for the run is 
required.  This can be used if adjustments to only the Baseline, Noise or Peak Detect settings 
are desired while maintaining the existing calibration. 

b. Default:  Utilizes the calibration coefficients found during calibration of the tune parameters. 
c. Lockmass: Utilizes specific peaks to calibrate the remaining data, like internal calibration, 

but the calibration is applied to the entire run. 

 
d. External: Utilizes an independant tofcal2 file for Calibration parameters.  
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e. Internal: Utilizes masses in a specified time period to calculate calibration coefficients. 

 

2. Select the desired calibration type and make any necessary updates to parameters.  Choose the 
Select Files button and select the tofdata2 files to be processed.  Then select Convert Files.  The 
right-side display will show progress.   
The new tofline files are written to the same directory as the source tofdata files. 
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The example shown here illustrates how to use post-run Lockmass on caffeine data within the TOF MS 
Driver application. 

3. In the TOF MS Driver, select Open Data File from the File menu. 

 
The Open dialog displays. 

 

4. Select a data file then click Open. In this example we selected: 

      4905_ExternalCalibOct10NoUV_Caffeine20ppma_1_12011-10-10-04-16-39.tofData2 

5. Click on a data point in the TIC where you see caffeine (m/z 195) and the two lock masses (m/z 118 
and m/z 922) before clicking on the Mass screen. 

 
Click on the spectral screen, if the masses display with two decimal points, you should change this to 
five decimal points. 

 
 

For example click on this 
data point 
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6. Select Annotation from the View menu. 

 
The Chromatogram Annotation dialog displays. 

 

7. Type 5 for Decimal places then click OK. 
Observe that the masses now have five decimal places. 

 

8. Select Lockmass from the Calibration menu. 

 
The Lockmass Calibration dialog displays. 

9. From the lock masses that were infused through the second ESI sprayer, select one mass on each 
side of the target mass. 
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This example shows a target m/z 195 (caffeine) that lies between m/z 118.08625 and 933.00979 
which are selected as the Lockmasses. 

 

10. To save the displayed masses for future analyses click Save. 
The Save As dialog displays. 

 

11. Type a File name. 
Notice that the file name has the extension .lmpref and it is saved in the same directory as your data. 

 

12. Once saved, you can click OK to run Lockmass on your data. 
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As Lockmass runs it creates a file with the extension .TOFCal2 in the same directory as your data. 
After the Lockmass run is complete you can select any data point and observe that the two 
Lockmasses do not change. The target mass should be accurate to within three decimal places 
anywhere on the TIC where the target mass resides. 
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Creating an Average Mass Spectrum in the TOF Driver  

Below is an example of how to analyze the TIC peak.  

Using the Left Mouse Button Command  

1. Left-click and drag a box around the peak of interest.  

2. Release the button and select the left mouse button command, Average Spectra.  

    

The Mass spectrum will be updated to an average mass spectrum.  

 

Using the Generate Mass Spectrum Dialog  

1. To create an average spectrum, activate the TIC spectrum and select Generate Spectrum from the 
View menu.    

2. In the Range Selection section, select whether to use Time Range or Spectra Range to define 
the average spectrum.    

3. If Time Range is selected, enter a Start Time and End Time in seconds. 
If Spectra Range has been selected enter the first and last spectrum number.  

4. Decide how to display the curves in the Curve Definition table. Enter the row identification (A,B) to 
display the curves, simply.  
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5. Decide how to display the mass spectra in the Display section.  

 

NOTE: Average spectra are not displayed in the same window as single spectra.  

6. Click OK.  
The Mass spectrum will be updated to an average Mass spectrum.  
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Creating an EIC and BIC from a Mass Spectrum  

To create an EIC: 

1. Left-click and drag a narrow box around a peak of interest in the Mass spectrum.  The width of the 
box will be the set m/z range.  

 

 

2. Release the mouse button and select Display EIC from the menu. 
The Extracted Ion Chromatogram (EIC) dialog displays. 

 

3. Click OK and the EIC is displayed. 
The EIC displays where in the chromatogram mass peaks occur with m/z values within the set m/z 
range.    
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To create a BIC: 

1. Left-click and drag a narrow box around a peak of interest in the mass spectrum.   
In this example it is the 195.03 m/z peak.  The width of the box will be the set m/z range.  

 

2. Release the mouse button and select Display BIC from the menu.  
The Base Peak Preferences dialog displays. 

3. In the Trace Selection section only select Amplitude. 
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4. Click OK and the BIC is displayed.  
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Processing of Mass Spectra in the TOF Driver Window  

NOTE: In some functions the ability to select "undo" is not available. We recommend creating spectra in a new 
window before using functions like subtract baseline, subtract threshold, and smoothing.  Otherwise, a 
new spectrum has to be generated in order to revert to the original display.    

Freezing and Thaw ing Mass Spectra 

As you acquire in real time, you can Freeze the Mass spectra window at any point you select and perform 
functions on that mass without waiting for acquire to complete. 

To freeze and thaw Mass Spectra: 

1. When a mass spectrum is created using the "hand" the mass spectrum can be frozen by activating 
the spectrum window and selecting Freeze from the Spectrum View menu 

2. Then, when a new spectrum is created it will be displayed in a new window. The previous spectrum 
is still available.  

3. To thaw a frozen mass spectrum, activate the spectrum and select Thaw from the View menu. 

Zooming In 

To zoom in:  

1. Left-click and drag a box around the area of interest.  

2.  Release the button and select Zoom X-axis.  

     

3. Left-click and drag a box somewhere in the spectrum.  Release button and select Zoom Out.  

4. Use the left-mouse button command Undo Zoom.  
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Displaying Statistics 

You can display statistics on a spectrum, EIC, TIC, or BIC. 

To display statistics: 

1. Left-click and drag a box around the area of interest.  

2.  Release the button and select Display Statistics.  

    

Using Right Mouse Click Menus    

The application obtains a graphical package which includes functions to modify and export graphs.  
Individual functions can be selected or the Customization Dialog can be used.  

Baseline Calculations 

You can perform baseline calculations on a spectrum, EIC, TIC, or BIC. 

To calculate a baseline:  

1. When a mass spectrum window is selected, select Baseline from the Evaluation menu. 

 

2. To calculate an Auto baseline with the morphological function, select Auto and the Function APB 
morph. 
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3. Enter shortest Baseline Segment Size, and Baseline Noise Window.  

 NOTE: An increased Baseline segment value will flatten the baseline.  A decreased value may lead to a baseline 
which interferes with the peaks.    

The level of the calculated baseline is found in the Peak Information box when Manual peak detection 
is used.  

4. Select Manual to create a Manual baseline by entering a value resulting in a straight line as a 
baseline.  

5. The baseline can be hidden or displayed with the Baseline from the View menu.  

6. The baseline can be subtracted from the chromatogram by selecting Subtract Baseline from the 
Evaluation menu.  

Setting Spectrum Noise Calculation Preferences 

You can set spectrum noise calculation preferences on a spectrum, EIC, TIC, or BIC. 

To set mass spectrum noise calculation preferences: 

1. When a mass spectrum window is activated, select Noise from the Evaluation menu. 

 

2. To detect the noise manually, select Manual and enter a mass range where there are not any peaks.    

3. Select a Function:  Peak to peak or 1-6 Times SD.  

4. In the default version of the signal to noise calculation the following is done:  

• If the noise is Peak to peak then the amplitude of the peak top or the centroid is subtracted 
by the low value of the noise and divided by the peak-to-peak difference.  

• If the noise is 1-6 Times SD then the amplitude of the peak top or the centroid is subtracted by 
the mean of the noise and divided by six times the standard deviation of the noise.    

5. Click OK. 
The level of the calculated noise is found in the Peak Information box when Manual peak detection is 
used.  
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Setting the Mass Spectrum Threshold 

To set the mass spectrum threshold: 

1. Select a mass spectrum.  Select Threshold from the MS Evaluation menu.   

 

2. Enter a threshold value and decide if the mass spectrum will be subtracted with this value. 
The threshold can be hidden or displayed with the Threshold from the Chromatogram View menu.    

NOTE: If a new chromatogram has not been created, the "undo" function is not available.  To return to the 
original chromatogram, the data file has to be closed and opened again.  

Mass Spectrum Smoothing 

You can smooth mass spectrum on an EIC, TIC, or BIC. 

To smooth mass spectra: 

1. Activate a mass spectrum and select Smooth from the Evaluation menu. 

2. Enter the number of smooths (1-10), window size (0.01-10) and select the function by clicking on the 
drop-down list.  

 

  

 Mean: For each data point in the source spectrum, the 
processed curve is calculated as the average of the data points 
within the specified window. 

 Median: The processed spectrum is calculated as the median of 
the data points. 

 Savitzky-Golay 
 Gauissian 
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Mass Spectrum Peak Detection 

You can set mass spectrum peak detection on a spectrum, EIC, TIC, or BIC. 

Manual Peak Detection  

1. To display data points, select the right mouse button command Mark Data Points.  This makes it 
easier to see the individual data points in the spectrum. 

 

2. Move the mouse cursor to a data point until the "hand" is displayed. 

 

3. Right-click and a Peak Information box is displayed in the lower portion of the screen.  

 

NOTE: The S/N value is calculated using the centroid amplitude.    
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Automatic Peak detection  

1. Select the mass spectrum.  

2. Select Peak Detect from the MS Evaluation menu. 

 

3. In the Search Method section, select Full Spectrum or Partial Spectrum. 
If partial is selected, enter a Start and End m/z range.    

4. In the Selection Criteria section, enter a signal to noise limit.   
Peaks with a S/N lower than the entered value will be excluded.    

5. In the m/ z Assignment section, select Peak Top or Centroid.  
When Peak top is selected, a spline function will be used to find the top amplitude and its m/z value 
for each mass peak.   
If Centroid is selected, a centroid will be calculated using the upper 50% of the peak.  

6. To display a peak table, check the box Display Results. 
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7. Click OK. 

 

8. To annotate the m/z values in the mass spectrum, select Annotations from the View menu. Zoom-
in for a better display. 
The Mass Spectrum Annotation dialog displays. 
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9. To close the peak table, click the Close button below the table.  

10. To export the peak table, click the Export button below the table. The complete table will be copied 
to the clipboard.    

11. Open Microsoft Excel (or other spreadsheet software) and Paste in an empty data sheet.    

12. To print the table from Microsoft Excel, select Print from the File menu.  

 
 

 
 



Additional Features and 
Functions  
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AxION EC ID (Elemental Composition Identification) 

This supplemental software package for the AxION 2 TOF helps determine the elemental composition of 
known (“known unknowns”) and unknown (“unknown unknowns”) compounds found in a sample 
analysis. It calculates the elemental composition of the analyte based on the measured exact mass of the 
observed molecular ion (adduct- typically with a H+ attached) and the relative abundance of the isotope 
ratios in the molecular ion isotopic distribution. After calculating potential molecular formulas for the 
analyte, the software links to the PubChem Compound database and lists all the possible compounds 
(with associated structures) for that composition.  

To use this software, you will need an internet connection and the Windows 7 operating system.  

New  Features 

In order to assist users in creation of their own databases, two new tools were added into the software: 
(1) Formula (Polymer) generator, and (2) Formula Lookup. These two features use historical original 
approach of atom-combination in generating lists of candidate molecular formulas (contrarily to the 
default AxION ECID approach of database search). While the Formula Lookup feature is straightforward 
and simple, the Formula Generator is severely limited by its computational cost, which rapidly makes it 
too slow when generating molecules with high target mass (above m/z 500), consisting of large number 
of atom types. Therefore, Formula Generator should not be the “first choice” search in the mass range 
where PubChem provides many candidates, but it can be used when PubChem truly fails. 

Another new feature of the software is the ability for a user to interact with the Neutral Loss screen 
(previously called CID – collision-induced-dissociation) in order to analyze mass differences between 
spectral peaks. This document provides examples of use of these new features. 

Program start and default DB search 

AxION ECID is invoked by highlighting peaks thought by user to belong to a molecular isotope cluster 
from the M/z peak list of AxION TOF MS Driver software, as shown below. 

 
Figure 1. ECID tool is invoked by pressing “Find Formula…” button on the bottom of the peaklist panel of the Mass 
Spectrum window. 

(1) right-click 

(2) CNTR-left-click(s) 

(3) left-click 



Additional Features and Functions.  125 

 

When the tool is started this way, the main window is filled-in with experimental information, and the 
whole peak-list is loaded into ECID memory in order to allow Neutral Loss Analysis (as illustrated below). 
It is noteworthy, that ECID uses information provided in peak-list (not the spectrum); therefore the m/z 
peak-picking preferences will affect the input to the ECID tool.  

In this example, experimental target mass is 1322.0006 and PubChem Compound (PC) extract for this 
mass range is empty, which is listed in the Results panel, if the “Search DB” button is pressed, as shown 
in Figure 2. 

 

Figure 2. There are no records in Compound Extract DB above m/z of 1000. 

Neutral Loss analysis 

In the upper-right corner of the ECID window there is pull-down menu control for the Neutral Loss 
feature (“N-loss”), which refers to tool which calculates mass differences between masses listed in a 
peak-list, and compares them to a Compound extract neutral molecules, in order to assist user in 
assignment of relations between mass spectral peaks. Mass difference between peaks can be an 
indication of their chemical relation, as in the case shown in a spectrum of a polymer, or result from 
aspects of mechanisms of MS sampling (substitution of a charge agent in electrospray), or ion transfer: 
in-source collision-induced dissociation, etc. 

There are two modes in which neutral losses can be viewed: “P→F” , (”parent to fragments”), stands for 
listing of mass difference between the target parent ion peak and every other peak in the spectrum, 
subject to intensity cutoff limits (which are currently not user-selectable, and set for …. ). If this option is 
selected, and a user clicks on a line in the results panel, as shown in Figure 3a, all neutral molecules 

(1) left-click 

(search results) 
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listed in Compound (PC) extract whose mass corresponds to experimental mass difference are listed as 
potential candidates for the neutral loss, as Shown in Figure 4b. Note that the “ppM error cutoff” limit in 
this case needs to be low, otherwise unknown parent ion “allows” all possible elements to be present in 
the candidate, making the lists “crowd” the screen. If the parent ion is a found, or generated formula, 
only elements present in the parent are allowed in the neutral loss. Alternatively, a user can click on the 
“Elements” button in the left-middle part of the ECID window, to bring-up the element-restriction tool. 

 

Figure 3a. activation of parent-to-fragments neutral loss utility 

(1) select 

(2) tighten cutoff 

(3) left-click 
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Figure 3b. parent-to-fragments neutral loss display for an unknown parent ion 

If the candidate parent ion is unknown, experimental mass listed in ECID “Monoisotopic peak, (m/z)” 
edit-box is used; if the parent ion is one of the found candidate formulas – its theoretical mass is used. 
Isotope ratio information is not used. 

The zoom  and move   buttons on the top tool menu of the neutral loss window – when 
selected – allow user not only to change the display of the neutral loss spectrum, but also to limit the 
neutral loss search only to peaks currently shown in the window. When all the tool buttons are 
deselected (default state), mouse left-click over the spectrum becomes active for individual mass 
difference activation. When a user clicks on a pair of peaks, only the neutral loss between the pair of the 
peaks is listed, as shown in Figure 4. 
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Figure 4. User interactive neutral loss listing. 

In the shown example of a target parent ion, the second mode of neutral loss analysis proves useful. Here, 
“P→F→F” stands for “parent-to-fragment-to-fragment”, the representation of sequential neutral losses, 
which in case of CID would correspond to sequential parent ion decomposition, but in this case reflect the 
polymer nature of the sample: the “neutral loss” mass is simply the mass of the polymer repeating unit. In 
other cases it can be an end unit of a branched polymer, etc. Figure 6 shows the result of “P→F→F” listing 
of neutral losses. Notice that only the top of the spectrum has to be within the zoom, otherwise the 
sequential loss is calculated between every pair of adjacent peaks, including lower abundance higher 
isotopes. In this example, both losses list C2F4, which could be our polymer repeating unit. 

 
Figure 5. “sequential” neutral loss reveals polymer repeating unit 
  

(1) unselect 

(3) left-click 

(2) left-click 
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Polymer and Formula Generator 

Having gained some clues into the polymer identity, user can proceed to the atom-combination Formula 
Generator and Lookup, by pressing “Generator…” button in the left-middle part of the ECID window, 
which appears on the right of the main window, as shown in Figure 6. 

 

Figure 6. Activation of the Lookup and Generator window 

In some cases, user has an idea what the target ion could be. Formula Lookup (top panel) allows user to 
type in any valid molecular formula and  - by clicking “Check” button – report exact theoretical mass and 
display isotope distribution, as illustrated in the next Section. 

Straight-forward formula generation as shown in the default screen shot in Figure 7 is extremely 
computationally expensive, if all atoms types listed are allowed, and the typical maximum number of each 
atom type is used. Such search can only be performed in realistic time for target ions below 500 Da. In 
order to speed it up the concept of a polymer repeating unit is used as a super-atom, which allows to 
limit the left-over numbers of atom types, as if these atoms were truly on the ends of a polymer. 
Certainly, this formal approach applies not only for straight polymers; in the context of a formula 
generation it is simply a way to speed-up combinations search. Example of reasonably short combination 
generation is shown in Figure 7. 

(1) left-click 

(opens window) 
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Figure 7. Polymer-like formula generation. 

Careful examination of candidate results reveals redundant formulas, if too many atoms are allowed on 
the end units; these redundant formulas differ by number of repeating units, while the atoms of the 
repeating units are still listed in the formula, but assumed to be in the part of the molecule other than the 
repeating chain. From the stoichiometry stand point these formulas are identical. In order to get rid of 
them, and to significantly speed-up the generation – lower the “Max” number of atoms of appropriate 
types. 

Atom types allowed in Polymer and Formula generator usually are a small subset of “Elements…” allowed 
ion the main ECID periodic table tool. As a stronger restriction, Generator only uses its own allowed 
atoms. Explicit “end” unit choice is reserved for future use; in the current software release it is ignored: 
end units are calculated by direct formula generator. 

Formula Lookup 

As mentioned above, the upper panel of the Generator window allows to type-in any molecular formula 
and check its lowest-mass isotope mass and isotope distribution. But it also can be used to estimate what 
is on the ends of a polymer. In the shown case of –C2F4- chains, user can look up an accurate mass of 
just the repeating chain as shown in Figure 8. 

(1) adjust 

(3) adjust and (de)select 

(2) choose or type-in and select 

(4) left-click 
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Figure 9. Using Formula Lookup feature 

As shown in the spectral lower part of results panel, formula typed in the Lookup box is calculated 
exactly, with no account for the “Charge carrier” listed in the upper-left part of the main ECID window. 
However, “+” and “-“ will be recognized when typed directly at the end of a formula in the Lookup panel, 
resulting in respective subtraction or addition of an electron, respectively.  In the given example, user 
sees that the difference between the maximum number of repeating units (13) and the experimental 
target mass of 1322.0006 equals 1322.0006-1299.917=22.0836, hardly indicating anything straight-
forward. The next lowest number of repeating units is 12, suggesting the combined mass of 1199.923, 
and the total end unit mass of 122.0776. This mass can be manually typed into the “Monoisotopic mass” 
of the main ECID window for direct interrogation by default database search (isotope ratios will have to 
be adjusted, of their acceptance limits – expanded). 

  

(1) Type and press 

Results are shown 
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Running AxION EC ID 

The following example takes you through a simple analysis to show how AxION EC ID can be used to find 
possible compounds and their structures. 

 

1. Open AxION EC ID by clicking on this icon on your desktop. 

  
The following default window appears: 

 
  

Mass of Ion Measured 

Relative ion abundances and 
associated isotopes 
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2. Input the exact mass of the most abundant molecular ion and the observed % ratios of the 
molecular ion isotopic cluster as measured by the AxION 2 TOF.  

 

 
In the example above, the exact mass of the ion measured is m/z 216.1014 and relative % ion 
abundance of ions A, A+1, A+2, A+3 are 100, 12.99, 29.77 and 1.75 respectively. The relative ion 
intensities can be obtained from the peak table associated with the spectrum observed.  

3. Choose a Charge carrier from the drop-down list.  
For electrospray or APCI analyses, the charge carrier species typically would be +(H+) for positive ion 
analysis and –(H+).  for negative ion analysis. 
Additional Charge carriers options will be discussed in a later part of the manual. 

4. Enter the expected mass error of your measurement in the ppM error cut-off field and Iso cum-
sigma, % (expected sum of errors of all isotope ratios from measurement).  

Typical values for the AxION 2 TOF are about 5 ppM mass error and 10% Iso cum-sigma, % 
using a default (external) calibration. This type of mass accuracy can be obtained on a temperature 
equilibrated system that had been pulsing over the acquisition mass range for at least 1-2 hours. 
However, there are other factors that also affect observed mass accuracy, so please consult the 
AxION 2 User Manual for additional information. Enter these values as shown below: 

Enter the exact mass 
determined of the most 
abundant (charged) 
molecular ion. 

Enter the relative 
abundances of the 
molecular ion isotopic 
distribution. 

Choose a charge carrier 
from the drop-down list. 
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5. Click the Find Formulae button. 
A window appears with a list of Candidates that meet the search criteria for mass accuracy and 
isotopic abundances. 
The window shows for each candidate the ppM error (between the measured mass and the 
expected mass) and the Score (from 0 to 1.000) for the given elemental composition. The higher 
the score, the better the match of the candidate to the unknown.   

 

6. To get structures for a given elemental composition, click in the Details checkbox, highlight the 
elemental composition, and click again on it. This opens a new window from the internet browser 

Comparison of the candidate’s 
theoretical isotope ratio and the 
measured isotope ratio. 

The mass error between the 
measured mass and the calculated 
mass of the candidate’s elemental 
composition. 

The list of candidates whose 
elemental composition and isotope 
ratio meet the search criteria. 

Enter ppm error for your 
measurement. 

Enter sum of errors of isotope 
ratios. 
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containing the PubChem Compound database.  This window lists the names of all possible 
compounds and structures with that elemental composition in the database.  

The following example shows a list of 33 compounds having the elemental composition C8H14ClN5. 
The compound analyzed in this case, atrazine, appears first on the list. 

 
Another window displays with Formula stat Details for ppm mass error and absolute isotope 
distribution error, ppM scores and isoscores. 

 

The actual analyte measured in this 
case, Atrazine, is first on the list. 

The PubChem compound database lists 
33 possible compounds with structures 
for the candidate’s elemental 
composition.  
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7. If the exact mass of a fragment ion is known, then you can enter it into following window.  After 
typing it, press the Enter key to provide further confirmation of the given elemental composition.  

 

8. Click on a given elemental composition in the AxION EC ID window to see if this composition can 
have this fragment as shown below-: 

 
The following  window will appear. 

Enter Mass of fragment ion as 
174.054 

Click on possible 
elemental composition  
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Charge Carrier Options 

The software provides you with several Charge carrier options. These are available to address the 
different potential adducts that can be formed during, and ionization processes that can take place in, 
LCMS analyses. The use of H+ as a charge carrier has already been demonstrated in the previous 
example.  

For positive ion mode adducts (in addition to H+), the available charge carriers options are NH4
+, Na+, K+.  

The charge carrier for a radical cation is listed as “+”, which represents the addition of an electron.  For 
negative ion mode analyses, the loss of H+ was previously mentioned, and the software also provides an 
option for the charge carrier Cl-.  For other potential charge carriers not listed, such as such as Li+ in 
positive mode or formate (or the addition of an electron) in negative mode, the user can simply input the 
specific mass of the charged species in “Blank” option for  charge carrier window.  The list of all charge 
carrier options and their masses are shown below: 
 

Charge Carrier Mass/Dalton 
H+     1.00728 

Na+ 22.9892 

K+ 38.9632 

+   0.0005 

NH4
+ 18.0338 

-H+   -1.00728 

Cl- 34.9694 

Blank Input mass for adduct such as 
formate, lithium or mass of an 
electron for radical anion 

 

The example below shows the use of a formate ion as a charge carrier during the analysis of vomitoxin 
by LCMS. 

1. Select the “blank” option from the charge carrier drop down menu.  

2. Enter 44.99820 u for the mass of a formate ion in the charge carrier input cell.  

The program determines that a neutral loss 
from the charged molecular ion could yield 
the fragment identified. This provides 
additional confirmation of the given 
elemental composition. 
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Since the expectation is that formate is the charge carrier, the normal isotopic profile of vomitoxin 
would have the addition of formate to each isotope.  Consequently, the most abundant, monoisotopic 
mass (with formate addition) needs to be entered, as well as the observed isotopic ratio. The 
tolerances for mass accuracy (ppM) and allowed error in measured relative isotopic ratios are also 
required.  

3. Click the Find Formulae button.  
After entering all information, the window will look like as given below and should provide the right 
elemental composition for vomitoxin with formate ion addition. 

 

 
 
Depending on the measured mass, the ppM error and the sum of errors of relative isotope ratios, the 
software might identify more than one possible elemental composition. To reduce the number of 
potential choices, you can use the exact mass of a fragment ion, as demonstrated in the previous 
example. If this is not possible, you can also eliminate some formulae options by evaluating certain 
candidates that have elements with somewhat “unique” isotopic distributions. 
 
The following example uses data from a testosterone analysis and demonstrates how a specific 
element with its isotopic distribution can be used to eliminate a potential elemental composition. 
 

Enter measured mass 
for formate adduct of 

vomitoxin. 

Enter exact mass for formate 
ion as charge carrier.  

Software finds correct 
elemental composition for 
vomitoxin (with formate). 

“Blank” selected for 
charge carrier. 
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Also, if you know the mass of fragment ion, and by following directions described earlier, certain 
elemental compositions can be eliminated by checking if it could be fragment ion of given elemental 
composition. You would need to enter the mass of frament ion in the window below and press enter. 

 

 

Now if you go back to the previous window, highlight and click the compound, then highlight and 
click the compound in the secong line.  Observe the results displayed in the black AxION EC ID 
window. This window displays Elemental loss mass candidate number to help you determine which 
composition to eliminate. 

Fragment ion eliminated the  
First formula which was wrong 

The formula with highest score, 
as a formula candidate, can be 
eliminated if you know that 
compound does not contain Si.  
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Importing Chromera Data and Methods 

To import the data into Chromera: 

1. Select Import from the Tools menu then select Chromera Results… 

 

The Import Results dialog appears: 

 

4. Click the browse button  to the right of Source file name. 
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The Open dialog appears: 

 

5. Navigate to the directory containing your data. 

6. Select the data file then click Open. 
This example shows data file name (External std-results.chxb), that appears in the Select 
batches to import list. 

 

7. Select External stds-UTM-2 then click the Import button. 
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The progress bar shows the import progress. Upon completion, the message Import of results 
successful appears in the Messages box. 

 

8. Click the Close button. 
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Setting the Calibration Vial and the Diverter Valve 

The Calibration Vial and Diverter Valve are controlled from the Ion Source tab in the Tune dialog.  
To specify settings for these peripherals in the Method, utilize the peripheral settings in the Method 
Editor. 

 Select the function from the Diverter Valve or Calibration Vial drop-down list you want to 
perform.  
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QuickStart Guide for LC-AxION 2  TOF MS Analysis Using 
“on the fly” Lockmass 

1. Prepare Calibration Mix Reagent with Caffeine as described on page 24. 

2. Launch the appropriate instrument configuration, then the application, in Chromera Manager. 

3. Select the Method section.  Then Select Tune Control in the right-side Control Panel.  This allows 
TOF MS Driver software to take control of AxION 2 TOF. 
Chromera will not control the TOF instrument until the TOF MS Driver application is closed and, in 
Chromera, Tune Control changes to Stack Control in the meantime. 

 

4. In Chromera select File, then Create/Edit MS method/Tune.  This opens the TOF MS Driver 
application. 

 

5. Minimize Chromera or select the icon in the Windows Taskbar to maximize the TOF MS Driver 
application.   
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The Application automatically displays the Method Editor with Acquisition Method COM loaded.  Close 
this method without saving. 

 

6. Select File then Open Manual Tune.  Select then Apply the appropriate Tune for the work being 
done.  Check the Mass Range and ensure the Acquisition Rate (labeled Spectra/Sec) is between 3-
5.  A 3 GHz acquisition rate is more than sufficient as the UHPLC peaks are wide enough (3-4 secs) 
that sufficient data points are collected over the peak. 

7. In the Manual Tune window, turn on the Calibrant Vial or Syringe and also turn on Acquisition. 

8. Once the signal appears steady, select Calibration then Configure from the main menu.  Select the 
desired calibration points (at least 4) and calibration settings.  Execute Calibration and save it if 
acceptable.  See section Default Calibration on page 36 for detailed instructions. 

9. In the manual tune make the following updates for lockmass and save the tune.  These changes 
adjust for HPLC flow of 0.4 mL/min to aid in de-clustering and desolvating the molecules: 

• Increase the Drying Gas Heater to 350-400 °C 
• Change the Drying Gas Flow to between 12-14 L/min 

NOTE: It is not necessary to set these values back to previous to recalibrate.  This is a one-time adjustment to 
the tune. 

10. Move the calibrant inlet to the left probe of the Dual ESI ion source and connect the LC effluent to 
the right probe of the source. 
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11. Without closing the TOF MS Driver, navigate back to Chromera and start the LC pump.  Flow rate 
should be set to between 0.4 and 0.5 mL/min. 

 

IMPORTANT: Please do not exceed 0.4-0.5 mL/min especially when using a highly aqueous solvent.  Greater 
than recommended flow will result in condensation on end plate.  Even using the highest setting 
on drying gas and source temp the condensation can be quite high.  Higher flow rates also 
diluted the calibrant solution and may make it impossible to get sufficient counts in each 
spectrum for successful lockmass. 

12. Without closing Chromera, navigate back to TOF MS Driver and confirm the lockmass calibrant ions 
are of sufficient signal counts with the HPLC flow also active. 

13. Adjust the positions of the dual sprayers to get the best signal of the analyte and the lockmass 
calibrants.   

a. The calibrant ions 195.0876 (from caffeine) and 622.0290 are used as lockmass ions for 
this particular example.  118.08625 and 922.00979 can also be used as lock mass 
calibrants instead, however. 

b. The goal of these adjustments is to ensure the counts on the lock mass calibrants are at 
least 3000 or greater (as high as 10-20,000 is acceptable).  The peak shape is also 
important i.e. no peak splitting should be seen on top of peak so that centroid of the 
peak is correctly assigned.  Peak splitting usually occurs if the counts are too low. 
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c. The “x” position refers to the horizontal movement of the probes.  The position of the 
probes relative to each other are fixed hence adjusting one probe adjusts the other 
probe automatically in the “x” direction.  The mark on the moving block (on the right side 
of the right probe) should be roughly between 10 and 11 of the “x” scale. 

 

d. The “y” direction refers to the tilt of the probes.  With the HPLC flow of 0.4 L/min, the tilt 
is usually kept in the middle of the scale.  The “y” position along with the drying gas 
heater temperature and drying gas flow prevent condensation of the HPLC solvent on the 
end plate.  The “y” position can be tilted closer towards the entrance (instead of leaving 
at the middle position) to get better signal as long as there is no condensation of liquid 
on the end plate.  

 

 

Set 
Horizontal 

 

Locations of the Source  
Setting Adjustments. 

Set the depth of the probe 
adjustment for balanced 
sensitivity. 

Set Tilt Position Here 
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e. The “z” position refers to the capillary inside of the probes.  Each probe can be moved in and 
out.  The “z” positions of both probes need to be adjusted so that the signal of the lockmass ions 
is the highest for the established x and y positions.  The plumes generated from both probes 
interact and adjusting the z position will affect (suppress or occasionally enhance) the signal of 
the lockmass ions.  Adjust the right probe first then the left probe while watching the screen for 
best signal of lockmass ions. 

      

NOTE: The process of adjusting the “z” position may have to repeat this a couple times to establish the best 
position.  Once this is done you do not have adjust again unless the signal for the lockmass ions is poor 
even after x and y positions have been adjusted. 

14. Perform a final check of the Lockmass ions for sufficient counts and acceptable peak shape.  Ensure 
the tune file is saved and then close it. 

15. From the main TOF MS Driver menu select New Acquisition Method. 

16. Configure and save the method, associating the tune that was just used in the previous steps.  Refer 
to the section titled Creating an MS Method, starting on page 60.  Be sure to include the lockmass 
parameters in the method.  The lockmass ions entered are to the accurate 4th decimal place with a 
search span of 50 mmu. 

17. Close TOF MS Driver and navigate back to Chromera. 

18. Create a new Chromera Method.  Refer to section Creating a Chromera Method, starting on page 
68.  Ensure the LC run time configured matches the desired total time in the TOF acquisition method 
and that Run Time Reconciliation is checked.   
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19. Save the Chromera method with a unique name and associate it to a group.  Reconcile the TOF 
method time when prompted. 

20. Update the settings in Chromera so centroiding is automatically performed on each data file after it is 
collected. 

a. Under Tools select Preferences. 

 

b. Enable the centroiding function in the AxION2 subsection by selecting Yes for 
Automatically Centroid. 

c. Optionally, the incorporation of a substance list in the data files (tofline) for use in AxION 
SOLO can be enabled.  Select Yes for Enable AxION Solo/XPO.  The path for locating 
the substance list also needs to be specified in Substance Data Path.  The actual 
substance list applied is defined per run. 

 

21. Create and save a Sequence using the Chromera method that was just created.  Refer to the section 
titled Creating a Chromera Sequence, starting on page 72.  
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 Optional:  Embed a target list in data files for analysis by AxION SOLO.  For each run 
definition, select the AxION SOLO button and navigate to the directory where the substance 
list xml file is saved.  Open the substance list and save.  Fill down the column for rest of the 
samples.  This sequence can be saved and then analyzed.  The centroided data files 
embedded with the xml target list when opened in solo will have the target list associated 
with them. 

22. Open the sequence to run.  Refer to the section titled , starting on page 79.  Start the run by 
selecting the green “play” button. 
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